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1. WIC Outreach Woman List 
The WIC Outreach Woman List window is the main dialog for accessing the 
functions within the Other Breastpump Issuance application.  The first step is to 
identify the WIC Outreach woman with which the staff member will work.  The 
Other Breastpump Issuance application provides the WIC Outreach Woman List 
functions to assist the user in locating the desired woman’s record or to add a new 
WIC Outreach woman’s information to the system so that she may be issued a 
breastpump and/or supplies. 

1.1  Menus 
The menus presented on the WIC Outreach Woman List Window provide mouse 
and keyboard functionality to functions within the Clinic application.  The list 
will consist of the following menus: 

• File 
• WIC Outreach Woman List 
• Activities  
• Help 

1.1.1 File Menu 
This File menu contains menu items for invoking the various global features 
of the Other Breastpump Issuance application.  It will have a mnemonic of 
‘F’.  When hovering over or selecting a file menu item, if a sub-list of items is 
available, the sub-list will automatically expand and be invoked.  The File 
menu will invoke as follows: 

• File 
o System Outputs 
o System Reports 
o System Tools 
o Exit 

1.1.1.1 System Outputs Menu Item 
This menu item allows the user to invoke the System Outputs function.  
This menu item will be enabled when the File menu is active.  It has a 
mnemonic of ‘O’. 

1.1.1.2 System Tools Menu Item 
This menu item allows the user to invoke the System Tools function.  This 
menu item will be enabled when the File menu is active.  It has a 
mnemonic of ‘S’. 

1.1.1.3 Exit 
This menu item allows the user to exit the Other Breastpump Issuance 
application.  This menu item will be enabled when the File menu is 
active.  It has a mnemonic of ‘X’. 
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1.1.2 File Menu Processes 

1.1.2.1 System Outputs 
Upon selection of the System Outputs menu item, the system will expand 
the sub-menu as follows: 

• System Outputs 
o Reports (mnemonic of ‘R’) 

1.1.2.1.1 

1.1.2.2.1 

1.1.2.2.2 

1.1.2.2.3 

Reports 

Upon selection of the Reports sub-menu item, the system will invoke 
the Generate Reports dialog described in this chapter. 

1.1.2.2 System Tools 
Upon selection of the System Tools menu item, the system will expand the 
sub-menu as follows: 

• System Tools 
o Change Password (mnemonic of ‘P’) 
o Select Clinic (mnemonic of ‘C’) 
o Set Default Printers (mnemonic of ‘D’) 

Change Password 

Upon selection of the Change Password sub-menu item, the system 
will invoke the Change password dialog as described in Security. 

Select Clinic 

Upon selection of the Select Clinic sub-menu item, the system will 
invoke the Select Clinic of Operation dialog described in System Tools. 

Set Default Printers 

Upon selection of the Set Default Printers sub-menu item, the system 
will invoke the Default Printers dialog as described in Common 
Interface Panels Chapter S – System Tools. 

1.1.2.3 Exit 
Upon selection of the Exit menu item, the system will close and exit the 
Other Breastpump Issuance Application. 
If the Exit menu item is selected and the user has an open dialog where 
updates are being made, the system will invoke the standard edits as 
defined in this chapter. 
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1.1.3 WIC Outreach Woman List Menu 
This menu contains menu items that allow the user to access functions of the 
WIC Outreach woman list.  It will have a mnemonic of ‘N’.  The menu will be 
enabled when the WIC Outreach Woman Window is active.  The WIC 
Outreach Woman List menu will be displayed as follows: 

• Add WIC Outreach Woman 
• Edit WIC Outreach Woman 
• Delete WIC Outreach Woman 

1.1.3.1 Add WIC Outreach Woman 
This menu item allows the user to create a new WIC Outreach woman 
record.  The menu item will be enabled when the WIC Outreach Woman 
List Window is active.  It has a mnemonic of ‘A’. 

1.1.3.2 Edit WIC Outreach Woman 
This menu item allows the user to change information about a WIC 
Outreach woman who is already on the system.  The menu item will be 
enabled when the WIC Outreach Woman List Window is active and a 
WIC Outreach woman record has been selected from the grid.  It has a 
mnemonic of ‘E’. 

1.1.3.3 Delete WIC Outreach Woman 
This menu item allows the user to delete a WIC Outreach woman record 
from the system.  The menu item will be enabled when the WIC Outreach 
Woman List Window is active and a WIC Outreach woman record has 
been selected from the grid.  It has a mnemonic of ‘D’. 

1.1.4 WIC Outreach Woman List Menu Processes 
This section describes the processes (navigation) that take place as a result of 
the actions taken on the menu. 

1.1.4.1 Add WIC Outreach Woman 
Upon selection of the Add WIC Outreach Woman menu item, the system 
will check the permissions for the currently logged-on user.  If the user 
does not have the appropriate permissions (WIC Outreach Woman.Add or 
Full Control) to create a new WIC Outreach woman record, the system 
invokes a standard error message with the text “You do not have the 
necessary permissions to create a new WIC Outreach woman.  Please see 
the supervisor.” 
If the user has the appropriate permissions, the system will invoke the 
WIC Outreach Woman dialog in Add mode as defined later in this 
chapter. 
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1.1.4.2 Edit WIC Outreach Woman 
Upon selection of the Edit WIC Outreach Woman menu item, the system 
will check the permissions for the currently logged-on user.  If the user 
does not have the appropriate permissions (WIC Outreach Woman.Add or 
Full Control) to edit a WIC Outreach woman’s record, the system invokes 
a standard error message with the text “You do not have the necessary 
permissions to modify a WIC Outreach woman’s record.  Please see the 
supervisor.” 
If the user has the appropriate permissions, the system will invoke the 
WIC Outreach Woman dialog in Edit mode as defined later in this 
chapter. 

1.1.4.3 Delete WIC Outreach Woman 
Upon selection of the Delete WIC Outreach Woman menu item ,the 
system will check the permissions for the currently logged-on user.  If the 
user does not have the appropriate permissions (WIC Outreach 
Woman.Add or Full Control) to delete a WIC Outreach woman’s record, 
the system invokes a standard error message with the text “You do not 
have the necessary permissions to delete a WIC Outreach woman’s 
record.  Please see the supervisor.” 
If the user had the appropriate permissions, the system will invoke a 
standard delete confirmation message with the text “Are you sure you 
want to delete {Name}?” where {Name} is the first name, middle initial 
(followed by a period), last name of the selected WIC Outreach woman.  
The responses of ‘Yes’ and ‘No’ will be available.   
If the user selects ‘Yes’, the system will perform edits to make sure there 
is no breastpump issuance activity for the selected WIC Outreach woman.   

• If the selected WIC Outreach woman has been issued 
breastfeeding items, the system will invoke a standard error 
message with the text “The selected WIC Outreach woman has 
been issued breastfeeding items.  Her record cannot be deleted.”  
The user is returned to the WIC Outreach Woman List.  There will 
be no change in the grid. 

• If the selected WIC Outreach woman has no issuance history, the 
system will delete the WIC Outreach woman and associated infant 
record(s) from the system.  The user is returned to the WIC 
Outreach Woman List.  The items on the grid will be refreshed. 

If the user selects ‘No’, the system will exit the delete function without 
deleting the WIC Outreach woman’s record and return the user to the 
WIC Outreach Woman List.  There will be no change in the grid. 
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1.1.5 Activities Menu 
This menu contains menu items that allow the user to perform functions on 
WIC Outreach women.  It will have a mnemonic of ‘A’.  This menu will be 
enabled when the WIC Outreach Woman List Window is active.  The 
activities menu will be displayed as follows: 

• Activities 
o Issue Breastfeeding Items 
o Breastpump Issuance History 

1.1.5.1 Issue Breastfeeding Items Menu Item 
This menu item will allow the user to issue breastfeeding items such as 
milk bags and nursing bras to WIC Outreach women.  The menu item will 
be enabled when the Activities menu is active.  It will have a mnemonic of 
‘I’. 

1.1.5.2 Breastpump Issuance History 
This menu item will allow the user to view breastpump issuance history 
or issue a breastpump to a WIC Outreach woman.  The menu item will be 
enabled when the Activities menu is active.  It will have a mnemonic of 
‘H’. 

1.1.6 Activities Menu Processes 

1.1.6.1 Issue Breastfeeding Items 
Upon selection of the Issue Breastfeeding Items menu item, the system 
will check the permissions of the currently logged-on user to determine if 
they have the appropriate permissions (BreastfeedingItemIssuance.View, 
Add or FullControl) to issue breastfeeding items to the WIC Outreach 
woman.  If the user does not have the appropriate permissions, the 
system will invoke a standard error message with the text “You do not 
have the necessary permissions to issue breastfeeding items.  Please see 
the supervisor.” 
If the user has the appropriate permissions, the system will invoke the 
Issue Breastfeeding Items dialog described in Clinic Chapter 09 – 
Participant Folder.  

1.1.6.2 Breastpump Issuance History 
Upon selection of the Breastpump Issuance History menu item the system 
will check the permissions of the currently logged-on user to determine if 
they have the appropriate permissions (BreastfeedingItemIssuance.View, 
Add or FullControl) to issue breastpumps to the WIC Outreach woman.  If 
the user does not have the appropriate permissions, the system will 
invoke a standard error message with the text “You do not have the 
necessary permissions to issue breastpumps.  Please see the supervisor.” 
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If the user has the appropriate permissions, the system will invoke the 
Item Issuance History dialog described in Clinic Chapter 09 – Participant 
Folder. 

1.1.7 Help Menu 
The Help menu is provided to assist the user in finding answers to questions 
about how to user the Clinic application.  This menu item will be enabled 
when the File menu is accessible.  It has a mnemonic of ‘H’.  The Help menu 
will be displayed as follows: 

• Help 
o Help on Screen 
o Other Breastpump Issuance Help Topics 
o About 

1.1.7.1 Help on Screen 
This menu item will allow the user to view panel-level help for the 
currently invoked screen.  This menu item will be enabled when the Help 
Menu is active.  This menu item has a mnemonic of ‘S’ and a shortcut key 
of ‘F1’. 

1.1.7.2 Other Breastpump Issuance Help Topics Menu Item 
This menu item will allow the user to view a list of help topics for the 
Other Breastpump Issuance application.  This menu item will be enabled 
when the Help menu is active.  It has a mnemonic of ‘O’.  

1.1.7.3 About Other Breastpump Issuance 
This menu item allows the user to view information about the software.  
This menu item will be enabled when the Help menu is active.  It has a 
mnemonic of ‘A’. 

1.1.8 Help Menu Processes 

1.1.8.1 Help on Screen 
Upon selection of the Help on Screen menu item, the system will invoke 
the Other Breastpump Issuance application panel level help.  This 
function is also invoked when pressing the F1 key. 

1.1.8.2 Other Breastpump Issuance 
Upon selection of the Other Breastpump Issuance Help Topics menu item, 
the system will invoke the Help Topics:  Other Breastpump Issuance Help 
System at the Index tab of the help function. 
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1.1.8.3 About Other Breastpump Issuance 
Upon selection of the About Other Breastpump Issuance menu item, the 
system will invoke the About Other Breastpump Issuance application 
information dialog. 

1.1.9 Toolbar   
This Toolbar contains items for invoking the various features of the Other 
Breastpump Issuance application. 

 
Figure 1- Toolbar 

 

1.1.9.1 System Outputs Toolbar Button 
This toolbar button allows the user to invoke the System Outputs 
function.  It will be enabled when the WIC Outreach Woman List is 
active.  It has a tool tip text of “System Outputs”. 

 
Figure 2- System Outputs Toolbar Button 

 

1.1.9.2 System Tools Toolbar Button 
This toolbar button allows the user to invoke the System Tools function.  
It will be enabled when the WIC Outreach Woman List is active.  It has a 
tool tip text of “System Tools”. 

 
Figure 3- System Tools Toolbar Button 

 

1.1.9.3 Exit Toolbar Button 
This toolbar button allows the user to exit the Clinic application.  It will 
be enabled when the WIC Outreach Woman List is active.  It has a tool 
tip text of “Exit Other Breastpump Issuance Application”. 

 
Figure 4- Exit Toolbar Button 
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1.1.10 Toolbar Processing 

1.1.10.1 System Outputs 
Upon selection of the System Outputs toolbar button, the system will expand 
the sub-menu as follows: 

• System Outputs 
o Reports (mnemonic of ‘R’) 

1.1.10.1.1 

1.1.10.2.1 

1.1.10.2.2 

1.1.10.2.3 

Reports 

Upon selection of the Reports sub-menu item, the system will invoke 
the Generate Reports dialog described in this chapter. 

1.1.10.2 System Tools 
Upon selection of the System Tools toolbar button, the system will expand 
the sub-menu as follows: 

• System Tools 
o Change Password (mnemonic of ‘P’) 
o Select Clinic (mnemonic of ‘C’) 
o Set Default Printers (mnemonic of ‘D’) 

Change Password 

Upon selection of the Change Password sub-menu item, the system 
will invoke the Set password dialog as described in Application 
Administration – Chapter 2 - Security. 

Select Clinic 

Upon selection of the Select Clinic sub-menu item, the system will 
invoke the Select Clinic of Operation dialog described in Common 
Interface Panels Chapter S - System Tools. 

Set Default Printers 

Upon selection of the Set Default Printers sub-menu item, the system 
will invoke the Default Printers dialog as described in Common 
Interface Panels Chapter S – System Tools. 

1.1.10.3 Exit 
Upon selection of the Exit toolbar button, the system will close and exit 
the Other Breastpump Issuance Application. 
If the Exit toolbar button is selected and the user has an open dialog 
where updates are being made, the system will invoke the standard edits 
as defined in this chapter. 
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1.2 WIC Outreach Woman List 
The initial dialog of the Other Breastpump Issuance system allows the user to 
reach all functions of the system including the WIC Outreach Woman records, 
Issue Breastfeeding Items, Breastpump Issuance History, the System Outputs, 
and System Tools.  The WIC Outreach Woman List creates the foundation of the 
Other Breastpump Issuance application.  This document describes the various 
functions for searching and displaying the WIC Outreach woman list.  The list 
may be searched in several ways: by WIC Outreach ID, by Infant DOB, and by 
one or more of the demographics search fields shown on the dialog. 

 
Figure 5 – WIC Outreach Woman List Dialog 

1.2.1 Controls 
This section describes the behavior of the controls on the WIC Outreach 
Woman List dialog. 

1.2.1.1 Selection Criteria Radio Button Group 
This control allows the user to select the search criteria to use when 
searching for information about a WIC Outreach woman.  The control will 
be enabled when the WIC Outreach Woman List dialog is active.  It will 
contain three radio buttons: 
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• WIC Outreach ID 
• Infant DOB 
• Demographics 

The Demographics button will initially be selected. 

1.2.1.2 WIC Outreach ID Masked Edit Box 
This control allows the user to specify the woman’s WIC Outreach ID 
number.  The masked edit box will be enabled when the WIC Outreach ID 
radio button is selected.  It will accept entry of only numeric digits.  The 
mask on the box will be “########”.  It will initially be blank.   

1.2.1.3 Infant DOB Calendar Control 
This control allows the user to specify the WIC Outreach woman’s infant 
date of birth.  The calendar control will be enabled when the Infant DOB 
radio button is selected.  It will accept entry of only numeric digits.  The 
date will initially be blank. 

1.2.1.4 Last Name Text Box   
This control allows the user to enter the last name for the mother.  The 
text box will be enabled when the WIC Outreach Woman List dialog is 
active.  Only characters A-Z, {space}, and the following characters (' . , -  ) 
are allowed.  The maximum size of this control will be twenty-five (25) 
characters. 

1.2.1.5 First Name Text Box   
This control allows the user to enter the first name for the mother.  The 
text box will be enabled when the WIC Outreach Woman List dialog is 
active.  Only characters A-Z, {space}, and the following characters (' . , -  ) 
are allowed.  The maximum size of this control will be twenty (20) 
characters. 

1.2.1.6 Middle Initial Text Box (MI) 
This control allows the user to enter the middle initial for mother.  The 
text box will be enabled when the WIC Outreach Woman List dialog is 
active.  The control will only accept entry of alpha characters.  The 
maximum size of this control will be one (1) character. 

1.2.1.7 Telephone Masked Edit Box 
The masked edit box will be enabled when the WIC Outreach Woman List 
dialog is active.  It will only allow the entry of numeric characters.  The 
mask for the box will be “###-###-####” to allow entry of an area code and 
seven digit telephone number.  The area code portion of this box will 
default from the established Clinic defaults. 
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1.2.1.8 Address Text Box   
The text box will be enabled when the WIC Outreach Woman List dialog 
is active.  Only characters A-Z, 0-9, {space}, and the following characters (' 
. - # / ) are allowed.  It will convert all entered characters to upper case.  
The maximum size of this control will be fifty (50) characters. 

1.2.1.9 City Text Box   
The text box will be enabled when the WIC Outreach Woman List dialog 
is active.  Only characters A-Z, {space}, and the following characters (' . , -  
) are allowed.  It will convert all entered characters to upper case.  The 
maximum size of this control will be twenty (20) characters. 

1.2.1.10 State Dropdown List 
The dropdown list will be enabled when the WIC Outreach Woman List 
dialog is active.  It will contain a list of valid state codes.  It will default to 
the value of your state. 

1.2.1.11 ZIP Code Masked Edit Box (ZIP) 
The masked edit box will be enabled when the WIC Outreach Woman List 
dialog is active.  It will only allow the entry of numeric characters.  The 
mask for the box will be “#####-####” to allow entry of a four digit ZIP 
extension, if known. 
A complete five digit ZIP code is required.  If any part of the four-digit 
extension is entered, the entire extension is required. 

1.2.1.12 Search Button 
This control allows the user to initiate a search for the WIC Outreach 
woman criteria specified.  The Search button will be enabled when the 
WIC Outreach Woman List dialog is active.  It will have a mnemonic of 
‘S’. 

1.2.1.13 Clear Button 
This control allows the user to clear the dialog to its originally defaulted 
values.  The Clear button will be enabled when the WIC Outreach Woman 
list dialog is active.  It will have a mnemonic of ‘C’. 

1.2.1.14 WIC Outreach Woman Display Grid 
This control allows the user to view and select a WIC Outreach woman’s 
record for Edit or Delete.  The display grid will be enabled when the WIC 
Outreach Woman list dialog is active.  It will consist of the following 
columns: 

• WIC Outreach ID 
• Last Name 
• First Name 
• Middle Initial 
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• Address 
• City 
• State 
• Zip Code 
• Telephone Number 
• Infant’s DOB  
• Infant’s Last Name 
• Infant’s First Name 
• Infant’s Middle Initial 

1.2.2 Processes 
This section describes the processes (navigation) that take place as a result of 
the actions taken on the WIC Outreach Woman List Window.   

1.2.2.1 Initializing the Interface 
Upon initial presentation of the dialog, the title bar text will be set to 
“WIC Outreach Woman List” 
The Demographics radio button will be initially selected. 
The following controls are initially blank (and disabled where indicated in 
parenthesis) 

• WIC Outreach ID radio button 
• WIC Outreach ID masked edit box (disabled) 
• Infant DOB radio button 
• Infant DOB calendar control (disabled) 
• Last Name 
• First Name 
• Middle Initial (MI) 
• Telephone 
• Address 
• City 
• ZIP Code (ZIP) 

WIC Outreach Woman List Grid is initially blank 

1.2.2.2 Edits for Search Criteria 
Upon selection of the Search button, then the WIC Outreach ID radio 
button is selected and no entry is made in the WIC Outreach ID field, the 
system will invoke a standard error message with the text “An entry is 
required for the WIC Outreach ID.” 
When the Infant DOB radio button is selected and no entry is made in the 
Infant DOB field, the system will invoke a standard error message with 
the text “An entry is required for the Infant DOB.” 
When the Demographics radio button is selected, and an entry is not 
made in at least one of the following controls: 

• Last Name text box 
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• First Name text box 
• Middle Initial text box 
• Telephone masked edit box 
• Address text box 
• City text box 
• State dropdown list 
• ZIP masked edit box 

The system will invoke a standard error message with the text “An entry 
is required for at least one of the Demographics fields to perform a 
search.” 
If an invalid date is entered in the Infant DOB calendar control, the 
system will invoke a standard error message with the text “Invalid date 
entered.” 
If the value entered into the Infant DOB calendar control is greater than 
the system date, the system will invoke a standard error message with 
the text “Date entered must be less than or equal to today’s date.” 

1.2.2.3 Display WIC Outreach Woman List 
Upon successful completion of the above edits, if a value exists, the 
system will perform a soft search combined with a Soundex search on the 
‘Last Name’ and ‘First Name’ fields.  (For example, if the user performs a 
search on the Last Name of ‘PATTER’, a combined Soundex and soft 
search would yield results similar to the following: PADDER, 
PADDERSON, PATTER, PATTERSON, POTTER, POTTERSON, 
POTTERS.) 
The system will provide a hard search for the remaining controls.   
The system will display all records found meeting the criteria in the WIC 
Outreach Woman List Grid.  
The first record in the list will be initially selected. 
If no records are found that meet the search criteria, the system will 
invoke a standard message with the text “No WIC Outreach woman 
matching your search criteria could be found ” Upon dismissal of the 
message, the system will then return to the WIC Outreach Woman List 
Window preserving the previously entered search criteria. 

1.2.2.4 Clear 
Upon selection of the Clear button, the system will clear and reset all 
controls on the WIC Outreach Woman List Window. 

1.2.2.5 Saving the Data 
There are no updateable controls on this dialog; therefore no data is saved 
to the database. 
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1.2.2.6 Data Map 
There are no updateable controls on this dialog; therefore no data is saved 
to the database. 
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1.3 WIC Outreach Woman 
The WIC Outreach Woman dialog allows the user to add or edit demographic 
information or infant information related to the WIC Outreach woman selected 
from the grid on the WIC Outreach Woman List.  The WIC Outreach Woman 
dialog is invoked by selecting the Add or Edit button from the WIC Outreach 
Woman List. 

 
Figure 6 - WIC Outreach Woman Dialog 

1.3.1 Controls 
This section describes the behavior of the controls on the WIC Outreach 
Woman dialog.  The controls for each tab are described as a separate section. 

1.3.1.1 Tab 
This control allows the user to maintain general information about a WIC 
Outreach woman who is set up in the system to receive breastfeeding 
items and/or breastpumps.  The control will be enabled when the WIC 
Outreach Woman dialog is enabled.   It will have the following tabs:  WIC 
Outreach Woman and Infant.  
Upon the change of the tab, the system will check for required fields.  If 
any required information has not been entered or is invalid, the system 
will present the error message.  Also, if information on one tab is required 
to be saved before presenting another tab, the system will prompt the 
user to confirm the save operation before continuing. 

1.3.1.1.1 Woman Tab 

The tab will be enabled when the WIC Outreach Woman dialog is 
enabled.  It will be the default tab for the dialog.   
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1.3.1.1.2 Infant Tab 

The tab will be enabled when the WIC Outreach Woman dialog is 
enabled.   

1.3.1.2 OK Button  
This control allows the user to save the WIC Outreach woman’s 
information.  The control will be enabled when the WIC Outreach Woman 
dialog is enabled for add and edit.  Characteristics for the OK button are 
defined in Consistencies. 
The system will check for required fields on each of the tabs.  If any 
required information has not been entered or is invalid, the system will 
present the appropriate error message.   

1.3.1.3 Cancel Button  
This control allows the user to exit the WIC Outreach Woman dialog.  The 
control will be enabled when the WIC Outreach Woman dialog is active in 
add and edit mode.  Characteristics for the Cancel button are defined in 
Consistencies. 

1.3.2 Processing 
This section describes the processes (navigation) that take place as a result of 
the actions taken on the WIC Outreach Woman dialog. 

1.3.2.1 Change Tabs 
Upon the change of the tab, the system will check for required fields.  If 
any required information has not been entered or is invalid, the system 
will present the error message.  Also, if information on one tab is required 
to be saved before presenting another tab, the system will prompt the 
user to confirm the save operation before continuing.   

1.3.2.2 OK 
Upon selection of the OK button, if any of the following controls are blank, 
the system will invoke a standard error message with the text: “An entry 
is required in the {control label}.” 

• Last Name text box 
• First Name text box 
• Address text box 
• City text box 
• ZIP masked edit box 

If a selection has not been made in the State, the system will invoke a 
standard error message with the text: “A selection is required in the 
State.” 
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1.3.2.3 Cancel 
Upon selection of the Cancel button, the system will dismiss the WIC 
Outreach Woman dialog and present the WIC Outreach Woman List 
dialog. 
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1.4 WIC Outreach Woman - Woman Tab 
The Woman Tab allows the user to enter or modify demographic information 
related to the WIC Outreach woman who will be receiving or is receiving 
breastfeeding items and/or breastpumps.  The Woman Tab of the WIC Outreach 
Woman dialog is invoked by selecting the Add or Edit button from the WIC 
Outreach Woman List. 

 
Figure 7 - WIC Outreach Woman - Woman Tab Dialog (Add Mode) 

1.4.1 Controls 
This section describes the behavior of the controls on the WIC Outreach 
Woman - Woman Tab dialog. 

1.4.1.1 WIC Outreach ID Text and Value Label 
This control allows the user to view the woman’s system assigned WIC 
Outreach ID number.  The information in the control is read only.  The 
value label will display in the inverse color of the form.   

1.4.1.2 Last Name Text Box   
This control allows the user to enter the last name for the mother.  The 
text box will be enabled when the WIC Outreach Woman - Woman Tab 
dialog is active.  Only characters A-Z, {space}, and the following 
characters (' . , -  ) are allowed.  The maximum size of this control will be 
twenty-five (25) characters. 
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1.4.1.3 First Name Text Box   
This control allows the user to enter the first name for the mother.  The 
text box will be enabled when the WIC Outreach Woman - Woman Tab 
dialog is active.  Only characters A-Z, {space}, and the following 
characters (' . , -  ) are allowed.  The maximum size of this control will be 
twenty (20) characters. 

1.4.1.4 Middle Initial Text Box (MI) 
This control allows the user to enter the middle initial for mother.  The 
text box will be enabled when the WIC Outreach Woman - Woman Tab 
dialog is active.  The control will only accept entry of alpha characters.  
The maximum size of this control will be one (1) character. 

1.4.1.5 Address Text Box   
The text box will be enabled when the WIC Outreach Woman - Woman 
Tab dialog is active.  Only characters A-Z, 0-9, {space}, and the following 
characters (' . - # / ) are allowed.  It will convert all entered characters to 
upper case.  The maximum size of this control will be fifty (50) characters. 

1.4.1.6 City Text Box   
The text box will be enabled when the WIC Outreach Woman - Woman 
Tab dialog is active.  Only characters A-Z, {space}, and the following 
characters (' . , -  ) are allowed.  It will convert all entered characters to 
upper case.  The maximum size of this control will be twenty (20) 
characters. 

1.4.1.7 State Dropdown List 
The dropdown list will be enabled when the WIC Outreach Woman - 
Woman Tab dialog is active.  It will contain a list of valid state codes.  It 
will default to the value of your state. 

1.4.1.8 ZIP Code Masked Edit Box (ZIP) 
The masked edit box will be enabled when the WIC Outreach Woman - 
Woman Tab dialog is active.  It will only allow the entry of numeric 
characters.  The mask for the box will be “#####-####” to allow entry of a 
four digit ZIP extension, if known. 
A complete five digit ZIP code is required.  If any part of the four-digit 
extension is entered, the entire extension is required. 

1.4.1.9 Telephone Masked Edit Box 
The masked edit box will be enabled when the WIC Outreach Woman - 
Woman Tab dialog is active.  It will only allow the entry of numeric 
characters.  The mask for the box will be “###-###-####” to allow entry of 
an area code and seven digit telephone number.  The area code portion of 
this box will default from the established Clinic defaults. 
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1.4.1.10 Manage Notes Button 
This control allows the user to manage note for the WIC Outreach woman 
and her infants.  The Manage Notes button will be enabled when the WIC 
Outreach Woman - Woman Tab dialog is displayed in Edit mode. 

1.4.1.11 OK Button 
This control allows the user to save the WIC Outreach woman 
demographic information.  The OK button will be enabled when the WIC 
Outreach Woman - Woman Tab dialog is active.  Characteristics of the 
OK button are defined in Consistencies. 

1.4.1.12 Cancel Button 
This control allows the user to exit the dialog without saving any 
information.  The Cancel button will be enabled when the WIC Outreach 
Woman - Woman Tab dialog is active.  Characteristics of the Cancel 
button are defined in Consistencies. 

1.4.2 Processes 
This section describes the processes (navigation) that take place as a result of 
the actions taken on the WIC Outreach Woman - Woman Tab.   

1.4.2.1 Initializing the Interface 
Upon initial presentation of the dialog, this tab (Woman) will be the 
default tab 
The title bar text will be initially set to “WIC Outreach Woman” 

1.4.2.1.1 

1.4.2.1.2 

In ADD mode: 

The following controls will initially be blank: 
• WIC Outreach ID 
• Last Name 
• First Name 
• Middle Initial (MI) 
• Address 
• City 
• ZIP Code (ZIP) 
• Telephone 

The Manage Notes button will be disabled. 

In EDIT Mode,  

The controls will be populated with the information related to the 
selection from the list grid on the WIC Outreach Woman List dialog. 
The Manage Notes button will be enabled. 
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1.4.2.2 Manage Notes 
Upon selection of the Manage Note button, the system will invoke the 
Manage Note dialog described in this chapter. 

1.4.2.3 Edits 
Upon selection of the Infant tab, if any of the following controls are blank, 
the system will invoke a standard error message with the text: “An entry 
is required in the {control label}.” 

• Last Name text box 
• First Name text box 
• Address text box 
• City text box 
• ZIP masked edit box 

If a selection has not been made in the State, the system will invoke a 
standard error message with the text: “A selection is required in the 
State.” 
All edits on the Woman Tab must be satisfied before the user can select 
the Infant Tab. 

1.4.2.4 Saving the Data 
Upon successful completion of the above-listed edits, the system will save 
the values to the database as defined in the Data Map below.  The system 
will and return the user to the WIC Outreach Woman List dialog. 
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1.4.2.5 Data Map 

Control Label Entity Attribute Business 
Rule 

WIC Outreach ID NonWIC Woman  NonWICWomanID System 
Generated 

Last Name NonWIC Woman  LastName  

First Name NonWIC Woman  FirstName  

Middle Initial NonWIC Woman  MiddleInitial  

Address NonWIC Woman  MailAddress  

City NonWIC Woman  MailCity  

State NonWIC Woman  MailState  

ZIP NonWIC Woman  MailZip  

Telephone NonWIC Woman  Telephone1  
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1.5 WIC Outreach Woman - Infant Tab 
This dialog allows the user to view the infant demographic information for the 
infant(s) associated with the WIC Outreach woman.  The Infant tab of the WIC 
Outreach Woman dialog is invoked by selecting the Infant tab of the WIC 
Outreach Woman dialog. 

 
Figure 8 - WIC Outreach Woman - Infant Tab Dialog 

1.5.1 Controls 
This section describes the behavior of the controls on the WIC Outreach 
Woman Infant Tab dialog. 

1.5.1.1 WIC Outreach Woman ID Text and Value Label 
This control allows the user to view the mother’s WIC Outreach ID 
number.  The information in the control is read only.  The value label will 
display in the inverse color of the form.    

1.5.1.2 WIC Outreach Woman Name Text and Value Label 
This control allows the user to view the mother’s full name.  The 
information in the control is read only.  The value label will display in the 
inverse color of the form.  The name will be displayed in the format First 
Name, Middle Initial (followed by a period if middle initial is not null), 
Last Name.   

1.5.1.3 Infant Information List Grid 
This control allows the user to view a list of infants associated with the 
WIC Outreach woman.  The information in the control is read only.  The 
infant information columns on the grid will consist of the following: 

• Last Name  
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• First Name 
• Middle Initial (MI) 
• Date of Birth 

1.5.1.4 Add Button 
This control allows the user to invoke the Infant dialog in Add mode in 
order to add an infant record for the WIC Outreach woman.  The Add 
button is enabled when the Infant Tab of the WIC Outreach Woman 
dialog is active.  It will have a mnemonic of ‘A’. 

1.5.1.5 Edit Button 
This control allows the user to invoke the Infant dialog in Edit mode in 
order to change infant information related to a WIC Outreach woman.  
The Edit button is enabled when the Infant Tab of the WIC Outreach 
Woman dialog is active.  It will have a mnemonic of ‘E’. 

1.5.1.6 Delete Button 
This control allows the user to delete an infant record that is associated 
with the selected WIC Outreach woman.  The Delete button is enabled 
when the Infant Tab of the WIC Outreach Woman dialog is active.  It will 
have a mnemonic of ‘D’. 

1.5.2 Processes 
This section describes the processes that take place on the WIC Outreach 
Woman Infant Tab dialog. 

1.5.2.1 Initializing the Interface 
Upon initial presentation of the dialog, the title bar text will be initially 
set to “WIC Outreach Woman” 
This tab (Infant) will be the tab with focus 
The WIC Outreach Woman ID and Name will be populated with the 
values associated with the selected woman’s record 
The Infant Information grid will contain a list of infants associated with 
the selected WIC Outreach woman 

1.5.2.2 Saving the Data 
There are no updateable controls on this dialog; therefore no data is saved 
to the database. 

1.5.2.3 Data Map 
There are no updateable controls on this dialog; therefore no data is saved 
to the database. 
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1.6 Infant 
This dialog allows the user to enter infant demographic information for a WIC 
Outreach woman.  The Infant dialog is invoked by selecting the Add or Edit 
button from the List of Infants on the Infant tab of the WIC Outreach Woman 
dialog. 

 
Figure 9 - Infant Dialog (Add Mode) 

1.6.1 Controls 

1.6.1.1 Infant Last Name Text Box (Last) 
This control allows the user to enter the last name for the infant of the 
woman.  The text box will be enabled when the Infant dialog is active.  
Only characters A-Z, {space}, and the following characters (' . , -  ) are 
allowed.  The maximum size of this control will be twenty-five (25) 
characters. 

1.6.1.2 Infant First Name Text Box (First) 
This control allows the user to enter the first name for the infant of the 
woman.  The text box will be enabled when the Infant dialog is active.  
Only characters A-Z, {space}, and the following characters (' . , -  ) are 
allowed.  The maximum size of this control will be twenty (20) characters. 

1.6.1.3 Infant Middle Initial Text Box (MI) 
This control allows the user to enter the middle initial for the infant of the 
woman.  The text box will be enabled when the Infant dialog is active.  
The control will only accept entry of alpha characters.  The maximum size 
of this control will be one (1) character. 

1.6.1.4 Infant Date of Birth Date Control  
This control allows the user to enter the date of birth for the infant of the 
woman.  The date control will be enabled when the Infant dialog is active.  
It will only accept entry of numeric digits.  The mask on the box will be 
“##/##/####” to accept a date with a four digit year. 
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1.6.1.5 OK Command Button  
This control allows the user to save the infant information.  The OK 
Command button will be enabled when the Infant dialog is active.  
Characteristics of the OK button are defined in Consistencies. 

1.6.1.6 Cancel Button 
This control allows the user to exit the Infant dialog.  The Cancel 
command button will be enabled when the Infant dialog is active.  
Characteristics of the Cancel button are defined in Consistencies. 

1.6.2 Processes 
This section describes the processes (navigation) that take place as a result of 
the actions taken on the Issue Breastpump to Woman not on WIC dialog. 

1.6.2.1 Initializing the Interface 
Upon initial display of the Infant dialog, the title bar text will be set to 
“Infant”. 
The following controls will be initially blank: 

• Infant Last Name text box 
• Infant First Name text box 
• Infant Middle Initial text box 
• Infant Date of Birth masked edit box 

1.6.2.2 Edits 
Upon selection of the OK button the system will invoke a standard error 
message with the text “An entry is required in the {control label}” if an 
entry is not made in the following: 

• Infant Last Name text box 
• Infant First Name text box 
• Infant Date of Birth calendar control 

1.6.2.3 Saving the Data 
Upon successful completion of the above-listed edits, the system will save 
the values to the database as defined in the Data Map below.  The system 
will exit the Infant dialog and return to the Infants tab of the WIC 
Outreach Woman dialog. 

1.6.2.4 Cancel 
Upon selection of the Cancel button, the system will dismiss the Infant 
dialog without saving any data and return the user to the Infants tab of 
the WIC Outreach Woman dialog. 
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1.6.2.5 Data Map 

Control Label Entity Attribute Business 
Rule 

 NonWICWomanInfant  System 
Generated 

  NonWICWomanInfant  Mother’s 
System 
Generated 
WIC 
Outreach ID 
from 
NonWICWom
an table 

Infant Last Name NonWICWomanInfant LastName  

Infant First Name NonWICWomanInfant FirstName  

Infant Middle Initial NonWICWomanInfant MiddleInitial  

Infant Date of Birth NonWICWomanInfant DateofBirth  
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1.7 View Notes for WIC Outreach Woman 
The View Notes dialog allows the user to view previously created notes for the 
current WIC Outreach Woman.  Additionally, the user may create a note for the 
WIC Outreach Woman.  The View Notes dialog is invoked when the user selects 
the Manage Notes button on the Woman tab of the WIC Outreach Woman dialog. 

 
Figure 10 - View Notes dialog 

1.7.1 Controls 
This section describes the behavior of the controls on the View Notes dialog. 

1.7.1.1 Notes for WIC Outreach Woman Display Grid 
This control allows the user to view the notes that have been previously 
defined for the WIC Outreach Woman.  The grid will be enabled when the 
View Notes dialog is active.  It consists of the following columns: 

• Date Created 
• Staff Member 
• Text 

The grid will be filled with an entry for each note recorded on the local 
database for the current WIC Outreach Woman. 
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The entries will be sorted according to the value of the Date Created 
column in the order indicated by the NoteSortOrder business rule.  If the 
NoteSortOrder business rule = ‘C’, the notes will be sorted chronologically 
by date.  If the NoteSortOrder business rule = ‘R’, the notes will be sorted 
in reverse chronological order by date.  The values in the control will be 
read-only. 

1.7.1.2 Selected Note View Text Box 
This control allows the user to view the actual text of the note.  The text 
box will be enabled when the View Notes dialog is active.  It will be filled 
with the actual text of the note selected in the Notes for WIC Outreach 
Woman display grid.  The contents of the control are read-only.  When the 
text exceeds the bounds of the text box, a vertical scroll bar will display. 

1.7.1.3 Create Note Button 
This control allows the user to create a new note for the current WIC 
Outreach Woman.  The Create Note button will be enabled when the View 
Notes dialog is active.  It has a mnemonic of “N”. 
Upon selection of the button, the system will check the permissions for 
the current user.  If the user does not have the appropriate permissions 
(Notes.Add) to create notes for the WIC Outreach Woman, the system will 
invoke a standard error message with the text “You do not have the 
necessary permissions to create notes.  Please see the supervisor.” 

1.7.1.4 Close Button 
This control allows the user to exit the View Notes dialog and return to 
the calling window.  The Close button will be enabled when the View 
Notes dialog is active.  Characteristics for the Close button are described 
in Consistencies. 

1.7.2 Processes 
This section describes the processes (navigation) that take place as a result of 
the actions taken on the View Notes dialog. 

1.7.2.1 Create Note 
Upon selection of the Create Note button, the system will invoke the 
Create Note dialog described in this document. 
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1.8 Create Note 
The Create Note dialog allows the user to create a note for the current selected 
WIC Outreach Woman.  The Create Note dialog is invoked when the user selects 
the Create Note button on the View Notes dialog. 

 
Figure 11 - Create Note Dialog 

1.8.1 Controls 
This section describes the behavior of the controls on the Create Note dialog. 

1.8.1.1 Note Text Box 
This control allows the user to enter the text of the note for the WIC 
Outreach Woman.  The text box will be enabled when the Create Note 
dialog is active.  When the text exceeds the bounds of the text box, a 
vertical scroll bar will display.  It will initially be blank.  The control will 
have focus upon entry to the dialog. 

1.8.1.2 OK Button 
This control allows the user to save the note and exit the Create Note 
dialog.  The OK button will be enabled when the Create Note dialog is 
active.  Characteristics for the OK button are defined in Consistencies. 

1.8.1.3 Cancel Button 
This control allows the user to discard changes made to the note and exit 
the Create Note dialog.  The Cancel button will be enabled when the 
Create Note dialog is active.  Characteristics for the Cancel button are 
defined in Consistencies. 
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1.8.2 Processes 
This section describes the processes (navigation) that take place as a result of 
the actions taken on the Create Note dialog. 

1.8.2.1 Initializing the Interface 
Upon initial display, set the title bar text to “Create Note”. 
The Note Text box will initially be blank. 
The Application Area will display the area of the application where the 
user was working right before they created the note. 
The Protected check box will initially be blank. 

1.8.2.2 Edits 
Upon selection of the OK button, if an entry is not made in the Note Text 
box, the system will invoke a standard error message with the text “An 
entry is required for the {control label}”. 

1.8.2.3 Save Note 
Upon selection of the OK button, the system will write the note 
information on the dialog to the database (see Data Map section below).  
The system will then close the Create Note dialog and return to the View 
Notes dialog. 

1.8.2.4 Data Map 

Control Label Entity Attribute Business 
Rule 

Note Text HealthNote NoteText  
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1.9 Generate Reports 
The Generate Reports dialog allows the user to select which report to generate.  
It is invoked when the user selects the Reports sub-menu item from the System 
Outputs menu located on the WIC Outreach Woman List dialog. 
Reports specific to the WIC Outreach Woman application have not been defined.  
It is conceivable that some unique reports will be identified later.  It is also 
possible to use the WIC participant reports reporting both WIC and WIC 
Outreach breastpump and breastfeeding item issuance separately within the 
same report or on separate reports generated in the same format. 
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